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Overview 1
1.1 1.1 Product Overview 

Applications for the TP 277 and OP 277 
The HMI devices TP 277 and OP 277 represent a further stage of development of the HMI 
devices TP 270-6 and OP 270-6. 
The HMI devices are based on the standard operating system Microsoft Windows CE.  
Compared with the Multi Panel MP 277, the TP 277 and the OP 277 offer an inexpensive 
scaled option. 
The mounting options and the functional scope of the TP 277 and OP 277 are compatible 
with the HMI devices in the 270 series. 
The TP 277 and OP 277 also have the following features: 
• The HMI devices can be operated on PROFINET via the Ethernet port. 
• The HMI devices feature a TFT screen with 256 colors. 
• The use of projects with scripts and logs is supported. 
In addition to the classic HMI application WinCC flexible, the HMI devices also support 
additional applications, for example: 
• Sm@rtService 
• Sm@rtAccess 
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1.2 1.2 Design of the HMI Device TP 277 

Front view and side view 

 
 

① Slot for a memory card  
② Display / Touch screen 
③ Mounting seal 
④ Recesses for mounting clamps 

Bottom view 

 
 

① Ports 
② Recesses for mounting clamps 
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Rear view 

 
 

① Slot for a memory card 
② Rating label 
③ DIP switch 
④ Interface name 

1.3 1.3 Design of the HMI Device OP 277 

Front view and side view 

 
 

① Slot for a memory card  
② Display 
③ Recesses for mounting clamps 
④ Mounting seal 
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Bottom view 

 
 

① Ports 
② Recesses for mounting clamps 

Rear view 

 
 

① Slot for a memory card  
② Rating label 
③ DIP switch 
④ Interface name 

1.4 1.4 Accessories 

Accessory kit 
The accessory kit is supplied with the HMI device. 
The accessory kit contains the following: 
• A terminal block for the power supply 
• Mounting clamps for mounting the TP 277 
• Mounting clamps for mounting the OP 277 
Additional documents may be enclosed with the accessory kit.  
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RS 422-RS 232 Converter 
You need the converter in order to connect third-party PLCs. Connect the RS 422-RS 232 
converter to the RS 422/RS 485 port. The converter converts the input signals to RS-232 
signals.  
The converter is not supplied with the HMI device. The converter can be ordered separately 
under the order number 6AV6671-8XE00-0AX0. 

PC/PPI Cable 
The cable is required when updating the operating system by bootstrapping. You can also 
use the cable for transfer. Connect the PC/PPI cable to the RS 422/RS 485 port. The cable 
converts the input signals to RS-232 signals.  
The cable is not supplied with the HMI device. The cable can be ordered separately under 
the order number 6ES7901-3CB30-0XA0. 

 
 Note 

If the connection fails during the operating system update, set the system to a lower bit rate. 
If you wish to communicate at high bit rate, you must used a PC/PPI cable of version 3 or 
later. The version code is printed on the cable (e.g. "E-Stand 3" corresponds to version 3). 

90° Angle Adapter 
If space is restricted, you can use an angle adapter at the RS 422/RS 485 port.  
The adapter is not supplied with the HMI device. The adapter can be ordered separately 
under the order number 6AV6671-8XD00-0XA0. 

Protective Foil 
Protective foil is available for HMI devices with a touch screen.  
The protective foil is not supplied with the HMI device. The protective foil can be ordered 
separately under the order number 6AV6671-2XC00-0AX0.  

Memory Card 
Only use the SD memory cards tested and released by Siemens or multimedia cards. More 
information can be found in the SIMATIC HMI catalog ST 80.  
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1.5 1.5 Functional Scope with WinCC flexible 
The following tables show the objects which can be integrated in a project for a TP 277 or 
OP 277.  

Alarms 
 
Object Specification TP 277 / OP 277 

Number of discrete alarms 4.000 
Number of analog alarms 200 
Length of the alarm text 80 characters 
Number of tags in an alarm Max. 8 
Display Alarm line/Alarm 

window/Alarm view 
Acknowledge error message individually Yes 
Acknowledge several error messages simultaneously 
(group acknowledgement of alarm groups) 

16 alarm groups 

Edit alarm Yes 

Alarms 

Alarm indicator Yes 
ALARM_S Display S7 alarms Yes 

Alarm buffer capacity 512 alarms 
Simultaneously queued alarm events Max. 250 
View alarm Yes 
Delete alarm buffer Yes 

Alarm buffer, retentive 

Line-by-line printing of alarms Yes 

Tags, values and lists 
 
Object Specification TP 277 / OP 277 
Tags Number 2.048 
Limit value monitoring Input/Output Yes 
Linear Scaling Input/Output Yes 
Text lists Number 500 1) 
Graphics lists Number 400 1) 

 
1) The maximum total of text and graphics lists is 500.  
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PLC Protocol TP 277 / OP 277 
SIMATIC S7 • PPI 

• MPI  1) 
• PROFIBUS DP 
• TCP/IP (Ethernet) 

Yes 

SIMATIC S5 • PROFIBUS DP Yes 
SIMATIC 500/505 • NITP 

• PROFIBUS DP 
Yes 

SIMATIC HMI 
HTTP Protocol 

• HTTP/HTTPS (Ethernet) Yes 

Allen-Bradley PLC series SLC500, SLC501, SLC502, SLC503, 
SLC504, SLC505, MicroLogix and PLC5/11, 
PLC5/20, PLC5/30, PLC5/40, PLC5/60, PLC5/80 
• DF1 2) 5) 
• DH+ via KF2 module 3) 
• DH485 via KF3 module 4) 
• DH485 4) 

Yes 

GE Fanuc Automation PLC series 90–30, 90–70, VersaMax Micro 
• SNP 

Yes 

LG Industrial Systems 
(Lucky Goldstar) / IMO 

PLC series GLOFA GM (GM4, GM6 and GM7) / 
Series G4, G6 and G7 
• Dedicated communication 

Yes 

Mitsubishi Electric PLC series MELSEC FX and MELSEC FX0 
• FX 

Yes 

Mitsubishi Electric PLC series MELSEC FX0, FX1n, FX2n, AnA, 
AnN, AnS, AnU, QnA and QnAS 
• Protocol 4 

Yes 

OMRON PLC series SYSMAC C, SYSMAC CV, 
SYSMAC CS1, SYSMAC alpha and CP 
• Hostlink/Multilink (SYSMAC Way) 

Yes 

Modicon 
(Schneider Automation) 

PLC series Modicon 984, TSX Quantum and 
TSX Compact 
• Modbus RTU 5) 
PLC series Quantum, Momentum, Premium and 
Micro 
PLC series Compact and 984 via Ethernet bridge 
• Modbus TCP/IP  (Ethernet) 

Yes 

 
1) Not possible when connected to S7-212. 
2) Applies to controllers SLC503, SLC504, SLC505, PLC5, MicroLogix 
3) Applies to controllers SLC504, PLC5 over DF1 
4) Applies to controllers SLC500 to SLC 505 and MicroLogix 
5) only with converter RS 422-RS 232 6AV6 671-8XE00-0AX0 (option) 

See also 
Enabling PROFINET IO (Page 6-36) 
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Safety Instructions and General Notes 2
2.1 2.1 Safety Instructions 

Working on the cabinet 

 
Warning 
Open Equipment 
The HMI device is an open equipment. This means that the HMI device may only be installed 
in housings or cabinets, whereby the device can be operated from the front panel. 
Access to the housing or cabinet in which the HMI device is installed should only be possible 
by means of a key or tool and only for trained and authorized personnel.  
Dangerous Voltage 
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal. 
Switch off the power supply to the cabinet before opening it. 

Hazardous areas 
When operating the HMI device in hazardous areas the following warning applies. 

 
Warning 
Explosion Hazard 
Do not disconnect while circuit is live unless area is known to be non-hazardous. Substitution 
of components may impair suitability for Class I, Division 2 or Zone 2. 

High Frequency Radiation 

 Notice 
Unintentional Operating Situations 
High frequency radiation, for example from a cell phone, may cause unintentional operating 
situations. 

Proper use 

 
Warning 
Commissioning of the HMI device is forbidden until it has been absolutely ensured that the 
machine in which the HMI device is to be installed complies with Directive 98/37/EC. 
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2.2 2.2 Standards, Certificates and Approvals 

Certificates and approvals 
 

 
Caution 
The following overview shows possible approvals. 
The HMI device itself is certified as shown on the rear panel labels. 

CE approval 

 
 

The automation system meets the general and safety-related requirements of the following 
EC directives and conforms to the harmonized European standards (EN) for programmable 
logic controllers published in the official gazettes of the European Union: 
• 89/336/EEC "Electromagnetic Compatibility" (EMC Directive) 
• 98/37/EG Directive of the European Parliament and Council of 22 June 1998 on the 

approximation of the laws and administrative regulations of the Member States 
concerning machinery 

EC Declaration of Conformity 
The EC Declarations of Conformity are kept available for the responsible authorities at the 
following address: 
Siemens Aktiengesellschaft 
Automation & Drives 
A&D AS RD ST PLC 
PO Box 1963 
D-92209 Amberg, Germany 

UL approval 

 
 

Underwriters Laboratories Inc. conforming to  
• UL 508 (Industrial Control Equipment) 
• CSA C22.2 No. 142 (Process Control Equipment) 
or 
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Underwriters Laboratories Inc. conforming to  
• UL 508 (Industrial Control Equipment) 
• CSA C22.2 No. 142 (Process Control Equipment) 
• UL 1604 (Hazardous Location) 
• CSA-213 (Hazardous Location) 
Approved for use in 
• Class I, Division 2, Group A, B, C, D or 
• Class I, Zone 2, Group IIC or 
• non-hazardous locations 

FM Approval 

FM
APPROVED  

 
Factory Mutual Research (FM) conforming to 
• Approval Standard Class Number 3611, 3600, 3810 
Approved for use in 
• Class I, Division 2, Group A, B, C, D T4 
• Class I, Zone 2, Group IIC T4 

Label for Australia 

N117  
 

The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A). 

IEC 61131 
The HMI device fulfills the requirements and criteria conforming to IEC 61131-2, 
Programmable Logic Controllers, Part 2: Operating resource requirements and tests.  
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2.3 2.3 Notes about Usage 

Industrial Use 
The HMI device is designed for industrial use. The following standards are met: 
• Requirements of the emission of interference EN 61000-6-4: 2001 
• Requirements for noise immunity EN 61000-6-2: 2001 

Residential Use 
If the HMI device is used in a residential area, you must take measures to achieve Limit 
Class B conforming to EN 55011 for RF interference. 
Suitable measures to achieve Limit Class B for suppression of radio interference include: 
• Installation of the HMI device in a grounded cabinet 
• Use of filters in electrical supply lines 
Individual acceptance is required.  

See also 
Spare Parts and Repairs (Page 11-3) 

2.4 2.4 Electromagnetic Compatibility 

Introduction 
The HMI device fulfills requirements of the EMC directive of the domestic European market 
and other requirements. 

EMC-compliant Mounting of HMI Devices 
EMC-compliant mounting of the HMI device and the use of interference-proof cables will 
ensure trouble-free operation. The "Directives for interference-free installation of PLCs" and 
the "PROFIBUS Networks" manual also apply for the installation of the HMI device. 

Pulse-shaped Interference 
The table below shows the electromagnetic compatibility of modules in relation to pulse-
shaped interference. This requires the HMI device to meet the specifications and directives 
for electrical installation. 
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Pulse-shaped 
interference 

Tested with Corresponds to test 
intensity 

Electrostatic discharge 
conforming to  
IEC 61000-4-2 

Air discharge: 8 kV 
Contact discharge: 6 kV 

3 

Burst pulses 
(high-speed transient 
interference) 
conforming to 
IEC 61000-4-4 

2 KV power supply cable 
2 KV signal cable, > 30 m 
1 KV signal cable, < 30 m 

3 

High-power surge pulses conforming to IEC 61000-4-5, external protective circuit required (refer to 
S7 300 PLC, Installation, chapter “Lightning and Overvoltage Protection”). 
Asymmetric coupling 2 kV power cable 

DC voltage with protective elements 
2 KV signal/data cable, > 30 m, 
with protective elements as required 

3 

Symmetric coupling 1 kV power cable 
DC voltage with protective elements 
1 KV signal cable, > 30 m, 
with protective elements as required 

3 

Sinusoidal Interference 
The table below shows the EMC properties of the modules with respect to sinusoidal 
interference. This requires the HMI device to meet the specifications and directives for 
electrical installation. 

 
Sinusoidal interference Test values Corresponds to 

test intensity 
HF radiation 
(electromagnetic fields) 
according to  
IEC 61000-4-3 

• 80% amplitude modulation at 1 kHz  
with 10 V/m in the range of 80 MHz to 1 GHz 
with 3 V/m in the range 1.4 GHz to 2 GHz 
with 1 V/m the range 2 GHz to 2.7 GHz 

• 10 V/m with 50 % pulse modulation at 900 MHz 
10 V/m with 50 % pulse modulation at 1.89 GHz 

3 

RF interference current 
on cables and cable 
shielding conforming to 
IEC 61000-4-6 

Test voltage 10 V at 80% amplitude modulation of 
1 kHz in the range from 9 kHz to 80 MHz 

3 

Emission of Radio Interference 
The table below shows the emission values of electromagnetic interference conforming to 
EN 55011, limit value class A, Group 1, measured at a distance of 10 m: 

 
From 30 to 230 MHz < 40 dB (V/m) quasi-peak 
From 230 to 1000 MHz < 47 dB (V/m) quasi-peak 

Additional Measures 
If you wish to connect an HMI device to the public network, ensure that it is compliant to 
Limit Class B conforming to EN 55022.  
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2.5 2.5 Transport and Storage Conditions 

Mechanical and Climatic Transport and Storage Conditions 
The transport and storage conditions of this HMI device exceed requirements conforming to 
IEC 61131-2. The following specifications apply to the transport and storage of an HMI 
device in its original packing.  
The climatic conditions comply to the following standards: 
• IEC 60721-3-3, Class 3K7 for storage 
• IEC 60721-3-2, Class 2K4 for transport 
The mechanical conditions are compliant with IEC 60721-3-2, Class 2M2. 

 
Type of condition Permitted range 
Drop test (in transport package) ≤ 1 m 
Temperature from –20 to +60 °C 
Air pressure from 1080 hPa to 660 hPa, 

corresponds to an elevation of -1,000 m to 3,500 m 
Relative humidity from 10% to 90%, no condensation 
Sinusoidal vibration conforming to 
IEC 60068-2-6 

5 to 9 Hz: 3.5 mm 
9 to 500 Hz: 9.8 m/s2 

Shock conforming to IEC 60068-2-29 250 m/s2, 6 ms, 1,000 shocks 
 

 
 Notice 

Ensure that no condensation (dewing) develops on or inside the HMI device after 
transporting it at low temperatures or after it has been exposed to extreme temperature 
fluctuations. 
The HMI device must have acquired room temperature before it is put into operation. Do not 
expose the HMI device to direct radiation from a heater in order to warm it up. If dew has 
developed, wait approximately four hours until the HMI device has dried completely before 
switching it on.  

 
Proper transport and storage, installation and assembly as well as careful operation and 
maintenance are required to ensure trouble-free and safe operation of the HMI device. 
The warranty for the HMI device will be deemed void if these stipulations are not heeded.  
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4.3.2 Ports 
The figure below shows the ports of the HMI device.  

 
 

① Chassis terminal for equipotential bonding 
② Power supply connector 
③ RS 422/RS 485 interface (IF 1B) 
④ Ethernet port 
⑤ USB port 

 

 
 Notice 

Connecting external devices to the USB port 
If you wish to connect external devices with 230V power supply to the USB port, ensure that 
the installation is non-isolated.  

See also 
Power Supply (Page 12-6) 
RS 422/RS 485 (IF 1B) (Page 12-6) 
Ethernet (Page 12-7) 
USB (Page 12-7) 



Mounting and Connecting  
4.3 Connecting the HMI Device 

 TP 277, OP 277 (WinCC flexible) 
4-6 Operating Instructions, 09/2007, 6AV6691-1DH01-0AB0 

4.3.3 Connecting the Equipotential Bonding Circuit 

Electrical potential differences 
Differences in potential between spatially separated system parts may occur. The 
differences in potential can lead to high equalizing currents over the data cables and 
therefore to the destruction of their ports. Equalizing currents may arise if the cable shielding 
is terminated at both ends and grounded at different system parts.  
Differences in potential may develop when a system is connected to different mains. 

General Requirements for Equipotential Bonding 
Differences in potential must be reduced by means of equipotential bonding in order to 
ensure trouble-free operation of the relevant components of the electronic system. The 
following must therefore be observed when installing the equipotential bonding circuit: 
• The effectiveness of equipotential bonding increases as the impedance of the 

equipotential bonding conductor decreases or as its cross-section increases. 
• If two system parts are connected to each other via shielded data lines with shielding 

connected to the grounding/protective conductor on both sides, the impedance of the 
additionally installed equipotential bonding cables may not exceed 10% of the shielding 
impedance. 

• The cross-section of a selected equipotential bonding conductor must be capable of 
handling the maximum equalizing current. The best results in practical applications for 
equipotential bonding between two cabinets have been achieved with a minimum 
conductor cross-section of 16 mm². 

• Use equipotential bonding conductors made of copper or galvanized steel. Establish a 
large surface contact between the equipotential bonding conductors and the 
grounding/protective conductor and protect these from corrosion. 

• Clamp the shielding of the data cable on the HMI device flush and near the equipotential 
busbar using suitable cable clamps. 

• Route the equipotential bonding conductor and data cables in parallel with minimum 
clearance between these. 

 
  Notice 

Grounding conductor 
Cable shielding is not suitable for equipotential bonding. Always use the prescribed 
equipotential bonding conductors. The minimum cross-section of a conductor used for 
equipotential bonding is 16 mm². When you install MPI and PROFIBUS DP networks, 
always use cables with a sufficient cross-section. The interface modules may otherwise 
be damaged or destroyed. 
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Wiring diagram 

 
 

① Chassis terminal on the HMI device (example) 
② Equipotential bonding conductor cross-section: 4 mm2 
③ Cabinet 
④ Equipotential bonding conductor cross-section: min. 16 mm2 
⑤ Ground connection 
⑥ Cable clip 
⑦ Voltage bus 
⑧ Parallel routing of the equipotential bonding conductor and data cable 

See also 
Electromagnetic Compatibility (Page 2-4) 
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4.3.4 Connecting the Power Supply 

Wiring diagram 
The figure below illustrates the connection between the power supply and the HMI device. 

 

Note when connecting 
The power terminal block is included in the assembly kit. It is designed for conductors with a 
maximum cross-section of 1.5 mm2. 

Connecting the Terminal Block 
 
 Notice 

Damage 
Do not tighten the screws of the terminal block if it is plugged in. The pressure from the 
screwdriver may otherwise damage the HMI device socket. 
Always remove the terminal block to connect the wires. 

 
The following figure shows the connection of the HMI device to the power supply.  

 
 

Do not confuse the lines. Refer to the label for the contact pins on the rear of the HMI device. 
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Reverse Polarity Protection 
The HMI device is equipped with a reverse polarity protection circuit. 

Connecting the Power Supply 
 
 Caution 

Safety isolation 
Use only power supply units with safety isolation complying with IEC 60364-4-41 or 
HD 384.04.41 (VDE 0100, Part 410), for example according to the PELV standard, for the 
24 VDC supply.  
The supply voltage must be within the specified voltage range. Any other voltage might lead 
to failure of the HMI device. 
Applies to floating system design:  
Connect the connection for GND 24 V from the 24 V power supply output to equipotential 
bonding for uniform reference potential. For this purpose, choose a connecting point that is 
as close as possible to the center.  

See also 
Ports (Page 4-5) 
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4.3.5 Connecting the PLC 

Wiring diagram 
The figure below illustrates the connection between the HMI device and the PLC.  

 
 

 
 Notice 

Always use the approved cables to connect a SIMATIC S7 PLC. 
 

Standard cables are available for the connection. More information can be found in the 
SIMATIC HMI catalog ST 80. 
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Connecting PROFINET 
 
 Notice 

Use a cross-cable for the PROFINET connection when using a point-to-point connection. 
 
 Notice 

PROFINET IO 
If you use PROFINET IO direct keys, connect the HMI device with a switch. For detailed 
instructions regarding the installation of PROFINET networks, please refer to the PROFINET 
system description manual. 

 
Only connect the HMI device to public Ethernet networks using a switch or comparable 
device. 

Configuring the RS 422 / RS 485 Port 
A DIP switch for the configuration of the RS 422 / RS 485 port is located on the rear of the 
HMI device.  
In the factory state, the DIP switch is set for communication with the SIMATIC S7 controller 
via RS 485. 

 
 Note 

Note the diagrams of the DIP switch settings on the back of the HMI device. 
 

The following table shows the settings of the DIP switch. The transmitting and receiving 
direction is switched internally with the RTS signal. 

 
Communications Switch setting Meaning 

 
No RTS on plug, for data transfer between PLC and HMI 
device  
(factory state) 

 

RTS on pin 4, same as PLC, 
for example for commissioning 

RS 485 

 

RTS on pin 9, same as programming device, 
for example for commissioning 

RS 422 

 

RS 422 port is enabled. 

See also 
Ports (Page 4-5) 
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4.3.6 Connecting a Configuration PC 

Wiring Diagram 
The figure below illustrates the connection between the HMI device and the configuration 
PC.  

 
 

Use a cross-cable for the PROFINET connection when using a point-to-point connection.  
To use the RS 485/RS 232 port, order a PC/PPI cable from Siemens AG.  
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Configuring a PC/PPI Cable 
Use the DIP switches to configure the transfer rate of the PC/PPI cable. 

 
 Note 

If the connection fails during the operating system update, set the system to a lower bit rate. 
If you wish to communicate at high bit rate, you must used a PC/PPI cable of version 3 or 
later. The version code is printed on the cable (e.g. "E-Stand 3" corresponds to version 3). 

 

 
 

① DIP switch 
② LEDs 

Set the DIP switches 1 to 3 to the same value as in WinCC flexible. DIP switches 4 to 8 must 
be set to "0".  

 
 

① DIP switch 

The following table shows the adjustable bit rates. 
 

Bit rate in Kbps DIP switch 1 DIP switch 2 DIP switch 3 
115.2 1 1 0 
57.6 1 1 1 
38.4 0 0 0 
19.2 0 0 1 
9.6 0 1 0 
4.8 0 1 1 
2.4 1 0 0 
1.2 1 0 1 

The figure shows a bit rate of 115.2 Kbps. 



Mounting and Connecting  
4.3 Connecting the HMI Device 

 TP 277, OP 277 (WinCC flexible) 
4-14 Operating Instructions, 09/2007, 6AV6691-1DH01-0AB0 

Note when connecting 
 
 Notice 

USB Host-to-Host Cable 
Use only the driver for the USB host-to-host cable which is included in the WinCC flexible 
package. Do not use the driver which is supplied with the USB host adapter. 
Updating the operating system 
If there is no serviceable HMI device image on the HMI device, you can only update the 
operating system with a bootstrap. Use the RS 422 / RS 485 port with the PC/PPI cable on 
the HMI device.  

See also 
Ports (Page 4-5) 
Accessories (Page 1-4) 

4.3.7 Connect USB devices 
The following devices can be connected to the USB port of the HMI device:  
• External mouse 
• External keyboard 
• Printer 

Note when connecting 
 
 Notice 

Connecting external devices to the USB port 
If you wish to connect external devices with 230V power supply to the USB port, ensure that 
the installation is non-isolated. 

 
 Notice 

Rated Load of the Port 
Adhere to the values for the maximum load of the USB port. The values can be found in the 
Specifications section. If USB devices overload the port, malfunctions might occur.  

See also 
Connecting the Power Supply (Page 4-8) 
Ports (Page 4-5) 
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4.3.8 Connect a printer 

Wiring diagram 
The figure below illustrates the connection between the HMI device and the printer. 

 
 

Note when connecting 
 
 Notice 

Always use cables with metal shielding braid which is grounded on both ends between the 
printer and HMI device. 
Use a cross-cable for the Ethernet connection when using a point-to-point connection. 
Some printers may require the ASCII character set used in the project to also be defined on 
the printer. 

 
The list of current printers and required settings for HMI devices can be found on the Internet 
under "http://support.automation.siemens.com/WW/view/en/11376409".  
Observe the printer documentation when you connect the printer.  

See also 
Ports (Page 4-5) 
Connect USB devices (Page 4-14) 
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4.4 4.4 Switching on and Testing the HMI Device 

Procedure  
Proceed as follows: 
1. Switch on the power supply. 

The display lights up after power is switched on. A progress bar is displayed during 
startup. 
If the HMI device does not start, it is possible the wires on the terminal block have been 
crossed. Check the connected wires and change the connections, if necessary. The 
Loader is displayed once the operating system has started.  

 
 

The HMI device automatically switches to "Transfer" mode during initial startup under the 
following conditions: 
– No project is loaded on the device. 
– At least one data channel has been configured. 
During this process the following dialog appears:  

 
 

2. Touch "Cancel" to stop the transfer.  
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Result 
The Loader appears again. 

 
 Note 

When restarting the system, a project may already be loaded on the HMI device. The system 
then skips "Transfer" mode and starts the project. 
Use the relevant operator control to close the project. 
Further information on this may be available in your plant documentation. 

Function Test 
Perform a function test following commissioning. The HMI device is in proper working order, 
if 
• The "Transfer" dialog is displayed. 
• The Loader appears. 
• A project is started. 

Switching off the HMI Device 
Terminate the project at the HMI device before switching it off. 
You have the following options for switching off the HMI device:  
• Switch off the power supply. 
• Disconnect the terminal block from the HMI device. 
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Operator Controls and Displays 5
5.1 5.1 Front-Side Operator Controls 

TP 277 

 
 

① Display with touch screen 

The TP 277 is operated with the touch screen. All operator controls required for operator 
input are displayed on the touch screen once the HMI has started.  
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OP 277 

 
 

① Display 
② Function keys 
③ Function keys with LED 
④ System keys - control keys 
⑤ System keys - cursor keys 
⑥ System keys - alphanumeric keys 

The OP 277 is operated using the system keys and the function keys. 
The function assigned to a specific function key is defined during configuration. The function 
keys have no function before a project has been opened. 

Note when operating 
 
 Notice 

Unintentional actions 
Do not carry out several operations simultaneously. You may otherwise trigger unintentional 
actions.  
• Operation using the touch screen: 
Always touch only one operator control on the screen. 
• Operation using the keys: 
Do not press more than two keys simultaneously. 
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 Notice 
Damaging to the touch screen 
Never touch the touch screen with pointed or sharp objects. Avoid applying excessive 
pressure to the touch screen with hard objects. Otherwise, the touch screen might fail, or its 
useful life might be considerably reduced. 
Always operate the HMI touch screen with your fingers or with a touch pen.  
Damage to the keyboard 
Only use your fingers to operate the HMI device keys. 
Pressing the keys with hard instruments considerably reduces the service life of the key 
mechanism.  

See also 
Design of the HMI Device TP 277 (Page 1-2) 
Design of the HMI Device OP 277 (Page 1-3) 

5.2 5.2 Using a Memory Card with the HMI device 

Introduction 
The following can be saved on the memory card of the HMI device: 
• Logs 
• Recipes 
• Operating system 
• Applications 
• Additional specifications 
The memory card can be inserted and removed during operation. D not remove the memory 
card while data is being accessed by an application, e.g. during backup or recipe transfer.  

 
 Notice 

Multimedia card 
The Multimedia card of the SIMATIC S7 controller cannot be used. 
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Procedure – Inserting a Memory Card 
Proceed as follows: 
Insert the memory card into the memory card slot. 

 
 

① Memory card interlock  
② Memory card 
③ Memory card slot 

When inserting the memory card, please note that it can only be inserted as shown in the 
diagram. The memory card is inserted correctly in the memory card slot when the card 
interlock engages. 

Using a Memory Card for the First Time 
 
 Notice 

Data loss 
The first time you use a memory card the HMI device will request that you format the card. 
Save a backup copy of memory card data to a PC beforehand. 

 
Do the following in order to prevent data loss: 
1. Cancel the formatting procedure by pressing "ESC". 
2. Save a backup copy of data which must not be lost, to a PC. 
3. Format the memory card on the HMI device. 
4. Transfer the backup data from the PC to the memory card. 

You can now transfer the backup data from the memory card to the HMI device. 
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Procedure – Ejecting a Memory Card 
 
 Notice 

Data loss 
All data on the memory card is lost, if you attempt to remove it while the HMI device is 
accessing its data. 
Do not remove the memory card while data is being accessed. Observe the corresponding 
alarms on the screen. 

 
 

① Eject button 

Proceed as follows: 
1. Press the ejection button. 

This ejects the memory card out of the slot. 
 
  Notice 

Do not force the ejector, as this could damage the eject mechanism. 
 

2. Store the memory card in a safe place. 

See also 
Backup and Restore with the Memory Card (Page 6-45) 
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5.3 5.3 Labeling the OP 277 Function Keys 

Introduction 
You can label the function keys as required for your project. Use labeling strips to do so. 

 
 Notice 

Do not write on the keyboard to label the function keys. 

Printing Labeling Strips 
WinCC flexible comes with a range of labeling strip templates. For more information on the 
filing location of the templates, refer to the WinCC flexible online help. 
Any printable and writable foil can be used as labeling strips. You can use transparency film, 
the keyboard membrane of the HMI device is printed on the reverse side. Use transparent 
foil so that the LEDs of the function keys can be seen. Permitted thickness of the labeling 
strip: 0.13 mm. Paper should not be used as labeling strips. 

Labeling strip dimensions 
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Operating the Keys of the User Interface 
The table below shows the shortcut keys for navigation in the user interface.  

 
Shortcut key Function 

CTRL
 + 

ESC
 

The task bar is activated with the open 
Windows CE start menu. 

ALT
 + 

ESC
 

The next active program is displayed. 

ALT
 + 

TAB
 

The Task Manager is opened. 

Operating the Keys in the Explorer 
The table below shows the shortcut keys for navigation in the Explorer.  

 
Shortcut key Function 

TAB
 

• Toggles the active window. 
• Toggles between the Windows CE Desktop 

and the window. 

FN  + HOME  
Selects the first entry. 

FN  + END  
Selects the last entry. 

CTRL
 + 

BA

 Selects everything, if the left LED of the key A-Z  
lights up 

ALT
 

Activates the menu bar. 

 
Changes to the parent level. 

ALT
 + 

CTRL
 

Opens the context menu. 

ALT
 + 

ENTER

 
Displays the properties. 

See also 
Changing Password Protection (Page 6-18) 
Switching on and Testing the HMI Device (Page 4-16) 
Configuring the Data Channel (Page 6-33) 
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6.2 6.2 Control Panel 

6.2.1 Overview 

Control Panel of the HMI Device 

 
 

At the HMI device Control Panel, adjust the following:  
• Date/time 
• Screen saver 
• Regional settings 
• Transfer settings 
• Network settings 
• Delay time 
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Opening the Control Panel 
The Control Panel can be opened as follows: 
• During the startup phase: 

Press "Control Panel" to open the HMI device Control Panel in the Loader. 
• In the current project: 

Operate the control object provided for the respective task, if configured. 
On HMI devices with key panel, you can open the Control Panel from the Windows CE start 
menu. 

1. Open the Windows CE start menu by pressing the key combination ESC  + CTRL . 

2. Open the Control Panel with "Settings > Control Panel". 

6.2.2 Reference 

Overview of Functions  
The table below shows the options for settings available at the Control Panel of the HMI 
device. 

 
Symbol Function Tab / entry 

 
Backup and Restore with the Memory Card – 

Setting the Device Name of the HMI Device "Device Name" 
 

Activating the Direct Connection "PC Connection " 

 
Setting the Date and Time "Date/Time" 

 
Configuring the Screen Keyboard – 

 
Setting the character repetition of the screen keyboard "Repeat" 

 
Setting the Double-Click "Double-Click" 

Changing the Network Configuration "Adapters" 
Setting the IP Address Dialog "Onboard LAN Ethernet" 

via "Properties" button 
"IP Address" 

Setting the Name Server  Dialog "Onboard LAN Ethernet" 
via "Properties" button 

"Name Servers" 

 

Changing the Logon Data "Identification" 
Backing up Registry Information "Persistent Storage" 
Changing Screen Settings 1)  "Display" 
Displaying Information about the HMI device "Device" 
Booting the HMI device "Device" 

 

Calibrating the Touch Screen 2)  "Touch" 

 
Changing Password Protection "Password Settings" 
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Symbol Function Tab / entry 

 
Changing the Printer Properties – 

 
Changing the PROFINET IO Setting – 

Changing Regional Settings "Regional " 
Changing the Number Format  "Number " 
Changing the Time Format  "Time " 

 

Changing the Date Format "Date " 
Changing MPI Settings "MPI" 

 
Changing PROFIBUS Settings "PROFIBUS" 

 
Setting the Screen Saver – 

Displaying the System Information "General" 
 

Displaying Memory Information "Memory" 
Configuring the Data Channel "Channel" 

 
Setting the Delay Time "Directories" 
Changing e-mail Settings 3)  "Email" 

 
Changing Settings for Proxy Server  "Proxy" 

 
1) No function 
2) TP 277 only 
3) The WinCC flexible Internet Settings" dialog may contain other tabs. This depends on the options that have been 

enabled for network operation in the project.  

6.2.3 Operating the Control Panel 

6.2.3.1 Overview 

Operator Control Options 
The hardware of the HMI device determines which of the following operator control options 
are available: 
• Touch screen 

The operator controls shown in the dialogs are touch-sensitive. Touch objects are 
basically operated in the same way as mechanical keys. You activate operator controls 
by touching them with your finger. To double-click them, touch an operator control twice 
in succession. 

• HMI-device keyboard 
The operator controls shown in the dialogs are selected and operated using the keys of 
the HMI device. 

• External USB keyboard 
• External USB mouse 
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Input with an External Keyboard 
An external keyboard can be used to operate the Control Panel in exactly the same way as 
the HMI device keyboard. Use the keys of the external keyboard which correspond to the 
HMI keys in the description.  

Operation with an External Mouse 
An external mouse can be used to operate the Control Panel in exactly the same way as the 
HMI-device touch screen. Click the described operator controls with the mouse.  

6.2.3.2 Input with the Touch Screen 

Introduction 
The Control Panel is operated with the HMI-device touch screen. 

Procedure 
Proceed as follows to change settings in the Control Panel:  
1. Close the project. 

Use the provided operator control. 
The Loader appears. 

2. Open the Control Panel by clicking "Control Panel". 
3. To open the required dialog, double-click its symbol. 
4. Change as required by touching the tab. 
5. Now make the necessary changes. 

Touch the respective input object to make entries. 
– Use the screen keyboard of the HMI device to enter the new values in the input fields. 
– Touch a button to operate it. 
– Touch the selection field to open a drop-down list. Touch the required entry from the 

drop-down list. 
– Touch the check box to activate or deactivate a check box. 
– Touch a radio button to select it. 

6. Confirm your entry by clicking  or discard your entry by clicking . 

The dialog closes. 

7. Close the Control Panel by clicking . 

8. Start the project by clicking "Start" in the Loader. 
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Input with the Screen Keyboard 
A special screen keyboard is available to enter information outside the open project, for 
example, in the Control Panel. The screen keyboard is displayed as soon as you touch an 
input field. You can also call the screen keyboard directly in the Control Panel. 

Display Methods for the Screen Keyboard 

You can change the display method for the screen keyboard and fix the position on the 
screen. Confirm your entries with  or discard your entries with . Either action closes 
the screen keyboard. 

• Numerical screen keyboard 

 
• Alphanumerical screen keyboard 

 
The alphanumerical screen keyboard has several levels: 
– Normal level 
– Shift level 

• Reduced screen keyboard 

 

Changing the display of the screen keyboard 
 

Key Function 

 Switching between the numerical and alphanumerical keyboard 

 
Switching between the normal level and Shift level of the alphanumerical screen 
keyboard 

 
Activation and deactivation of the numerical and alphanumerical keys of the 
alphanumerical screen keyboard 

 
Switching from full display to reduced display 

 
Switching from reduced display to full display 

 
Closing of reduced display of the screen keyboard 



 Configuring the Operating System 
 6.5 Changing HMI Device Settings 

TP 277, OP 277 (WinCC flexible) 
Operating Instructions, 09/2007, 6AV6691-1DH01-0AB0 6-19 

Procedure – Deactivating Password Protection 
Proceed as follows:  
1. Delete the entries in the "Password" and "Confirm Password" input fields. 
2. Apply your entries. 

The dialog closes. 

Result 
Password protection for the Control Panel and Windows CE taskbar is disabled.  

6.5 6.5 Changing HMI Device Settings 

6.5.1 Setting the Date and Time 

Introduction 
You can set the date and time on the HMI device. The HMI device must be restarted in the 
following cases: 
• You have changed the time zone setting. 
• You have changed the setting of the "Daylight savings time currently in effect" check box . 

Requirement 
The "Date/Time Properties" dialog has been opened with the "Date/Time Properties"  
button.  

 
 

① Time zone 
② Time 
③ Date 
④ "Daylight saving" check box 
⑤ Button for saving changes 
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Procedure 
Proceed as follows: 
1. Select the appropriate time zone for the HMI device in the "Time Zone" selection field. 
2. Touch the "Apply" button to confirm your entry. 

The time of day shown in the "Current Time" field is adjusted correspondingly to the 
selected time zone. 

3. Set the date in the selection field. 
4. Set the current time of day in the "Current Time" input field. 
5. If you wish to switch between daylight saving/standard time: 

– Activate the ""Daylight savings time currently in effect" check box. 
– Touch the "Apply" button to confirm your entries. 
The time is automatically adjusted by one hour on the respective days. 

6. Touch the "Apply" button to confirm your entries. 
The values you have set are now in effect. 

7. Confirm your entries. 
The dialog closes.  

Result 
The settings for the date and time of day have now been changed.  

Synchronizing the Date and Time with the Controller 
The date and time of the HMI device can be synchronized with the controller if this has been 
configured in the project and the controller program. 
Further information on this subject is available in the "WinCC flexible" system manual. 

 
 Notice 

You have to synchronize the date and time when time-controlled responses are triggered in 
the PLC by the HMI device.  

See also 
Restarting the HMI Device (Page 6-26) 
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6.5.2 Changing Regional Settings 

Introduction 
The display format of the date, time and decimal numbers etc. differ from region to region. 
You can adjust the display format to meet the requirements of different regions. 
The country-specific settings apply to the current project. If the project language is changed, 
the country-specific settings are also changed.  

Requirement 

The "Regional Settings Properties" dialog has been opened with the "Regional Settings"  
button.  

 
 

① Region selection box 

Procedure  
Proceed as follows: 
1. Select the region in the "Region" selection box. 
2. Change to the "Number", "Time" and "Date" tabs and make the required settings in the 

selection fields. 
3. Confirm your entries. 

The dialog closes. 

Result 
The HMI regional settings have been changed.  
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6.5.3 Backing up Registry Information 

Registry Information and Temporary Data 
You can install and uninstall your own programs on the HMI devices under Windows CE. 
You must save the registry settings after installation or uninstallation.  
You can save the following data to the flash memory: 
• Registry information 
• Temporary files 

Restoring the File System of a Memory Card 
If memory cards are used, the file system on the memory card may be become damaged, 
perhaps due to a power failure. The HMI device detects the defective file system on start-up 
or when the memory card is inserted. The HMI device can restore the file system 
automatically or on request.  

Requirements 

The "OP Properties" dialog, "Persistent Storage" tab, has been opened with the "OP"  
button. 

 
 

① Meaning of the text in the dialog: 
Saves the current registry information to the flash memory. The HMI device loads the saved 
registry information the next time it boots. 

② Button for saving registry information 
③ Button for saving temporary files 
④ Meaning of the text in the dialog: 

Saves all the files in temporary storage to the flash memory (for example, from the "Program 
Files" directory). These files are written back when the HMI device is started. The "\Temp" 
directory is not saved. 

⑤ Check box for automatically restoring the file system on the memory card when the HMI 
device starts up and when a memory card is inserted.  



 Configuring the Operating System 
 6.5 Changing HMI Device Settings 

TP 277, OP 277 (WinCC flexible) 
Operating Instructions, 09/2007, 6AV6691-1DH01-0AB0 6-23 

Procedure 
Proceed as follows:  
1. Select the "Save Registry" button to save the current registry settings. 
2. Select the "Save Files" button to save temporary files. 
3. Specify how the file system on the memory card should be restored. 

– Activate the check box "Automatically Repair ..." to activate automatic restore. 
– Deactivate the check box "Automatically Repair ..." if you wish to have the files system 

restored only upon prompting. 
4. Confirm your entries. 

The dialog closes. 

Result 
The HMI device uses the saved registry information the next time it starts. The temporary 
files are copied back.  

6.5.4 Setting the Screen Saver 

Introduction 
You can set a period of time for automatic activation of the screen saver on the HMI device. 
The screen saver is automatically activated if the HMI device is not operated within the 
specified period of time. 
The screen saver is deactivated when any key is pressed or when the touch screen is 
touched. The function assigned to that operator control is not triggered. 

 
 Notice 

Activating the Screen Saver 
You should always activate the screen saver. Otherwise, the screen contents may leave a 
burn-in effect in the background if they appear too long.  
This effect is reversible.  



Configuring the Operating System  
6.5 Changing HMI Device Settings 

 TP 277, OP 277 (WinCC flexible) 
6-24 Operating Instructions, 09/2007, 6AV6691-1DH01-0AB0 

Requirements 

You have opened the "Screen saver" dialog with the "ScreenSaver"  button.  

 
 

① Period of time in minutes before the screen is activated 
② Screen saver setting 

Procedure 
Proceed as follows:  
1. Enter the number of minutes before the screen saver is to be activated. 

The minimum time is 5 minutes and the maximum time is 71582 minutes. 
Alternatively, deactivate the screen saver with entry "0". 

2. Select either the standard screen saver or an empty screen. 
– Select the "Standard" check box to activate the screen saver. 
– Select the "Blank Screen" check box to activate a blank screen as the screen saver. 

3. Confirm your entries. 
The dialog closes. 

Result 
The screen saver for the HMI device has now been set.  

6.5.5 Changing the Printer Properties 

Introduction 
HMI devices can print on local printers or network printers. You can print hardcopies and 
logs on a network printer. Line printing of messages is not possible on a network printer. 
The list of current printers and required settings for HMI devices can be found on the Internet 
under "http://support.automation.siemens.com/WW/view/en/11376409". 

http://support.automation.siemens.com/WW/view/en/11376409
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Requirement 

You have opened the "Printer Properties" dialog with the "Printer"  button. 

 
 

① Printer selection field 
② Port  
③ Network address of the printer 
④ Paper size selection field 
⑤ Orientation setting 
⑥ Print quality setting 

Procedure 
Proceed as follows: 
1. Select the printer in the "Printer Language" selection field. 
2. Select the port for the printer in the "Port" selection field. 
3. If you are printing over the network, enter the network address of the printer in the 

"Network:" field. 
4. Select the paper format in the "Paper Size" selection field. 
5. Activated the required radio button in the "Orientation" group: 

– "Portrait" for vertical format 
– "Landscape" for horizontal format 

6. Select the print quality. 
– Select the check box "Draft Mode" if you wish to print a draft. 
– Deactivate the check box "Draft Mode" if you wish to print with higher quality. 

7. Set the color mode. 
– Select the check box "Color" if you wish to print in color. 

8. Confirm your entries. 
The dialog closes. 

Result 
The settings for the printer have now been changed. 
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6.5.6 Restarting the HMI Device 

Introduction 
The HMI device must be restarted in the following cases:  
• You have changed the network settings. 
• You have activated or deactivated the PROFINET IO direct keys. 
• You have changed the time zone setting. 
• You have changed the automatic daylight savings and standard setting. 

 

 
 Caution 

Data loss when the HMI device is restarted 
All volatile data is lost when the HMI device is rebooted.  
Check the following: 
• The project on the HMI device is not open. 
• No data is being written to the flash memory. 

Requirement 
You have opened the "OP Properties" dialog with the "OP" icon. 

Procedure 
1. Change to the "Device" tab in the "OP Properties" dialog. 
2. Restart the HMI device by selecting "Reboot". 

A warning is displayed. 
The HMI device reboots immediately if you confirm this warning. 

Result 
The HMI device starts.  

See also 
Enabling PROFINET IO (Page 6-36) 
Overview of Network Operation (Page 6-37) 
Setting the Date and Time (Page 6-19) 
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6.5.7 Displaying Information about the HMI Device 

Introduction 
OP 270 information required when you contact A&D Technical Support.  

Requirement 

The "Device" tab of the "OP Properties" dialog has been opened with the "OP"  button. 

The following figure shows the "Device" tab of the "OP Properties" dialog of OP 277.  

 
 

① HMI device name 
② Version of the HMI device image 
③ Version of the boot loader 
④ Boot loader release date 
⑤ Size of the internal flash memory in which the HMI device image and project are stored 
⑥ MAC address of the HMI device 
⑦ Button for restarting the HMI device 

Procedure 
Proceed as follows:  
1. The device-specific information is displayed in the "Device" tab. 
2. Close the dialog when the information is no longer required. 

 
  Note 

The size of the internal flash memory does not correspond to the available working 
memory for a project.  
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6.5.8 Displaying System Properties 

Introduction 
The system-specific information provides you with information about the processor, 
operating system and memory of the HMI device.  

Requirements 

The "System Properties" dialog has been opened with the "System"  button.  

 
 

① Copyright to Microsoft Windows CE 
② Information about the processor, size of the internal flash memory, and capacity of a memory 

card when inserted 

Displaying the system information 
The system information is displayed. This dialog is read-only. 
Close the dialog. 

Procedure - Displaying Memory Information 
 
 Notice 

"Memory" Tab 
Do not change the memory distribution in the "Memory" tab.  
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Proceed as follows:  
1. Change to the "Memory" tab. 

The memory information is displayed. 

 
2. Close the dialog. 

6.6 6.6 Setting the Delay Time 

Introduction 
The project is opened following a delay time when the HMI device is switched on. The 
Loader is displayed during the delay time. 

Requirement 

The "Transfer Settings" dialog, "Directories" tab, has been opened with the "Transfer"  
button. 

 
① Directory where the project file is saved 
② Directory where the compressed source file of your project is saved  

The external memory card or the network connection can be defined as the storage location. 
During the next backup process, the project's source file is stored in the specified location. 

③ Storage location and initialization file of the HMI device for process mode 
④ Selection field for the delay time 
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 Notice 
Settings in "Project File" and "Path" 
Do not change the setting in the "Project File" and "Path" fields. The project may not open at 
the next start of the HMI device if changes are made here.  

Procedure - Setting the Delay Time 
1. Select the desired delay time in seconds in the "Wait [sec]" selection field. 

With the value "0", the project starts immediately. It is then no longer possible to call the 
Loader after switching on the HMI device. If you still wish to access the Loader, an 
operator control must be configured to close the project. 

2. Confirm your entries. 
The dialog closes. 

Result 
The delay time for the HMI device is now set. 

6.7 6.7 Changing Communication Settings 

6.7.1 Changing MPI/PROFIBUS DP Settings 

Introduction 
The communication settings for MPI or PROFIBUS DP are defined in the HMI-device project. 
In the following cases, the communication settings might have to be changed: 
• The first time the project is transferred 
• If changes are made to the project but are only applied later 
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  Notice 
Transfer Mode Using MPI/PROFIBUS DP 
The bus parameters are read from the project currently loaded on the HMI device. 
The settings for MPI/PROFIBUS DP transfer can be modified. The following steps are 
required: 
• Close the project. 
• Change the settings on the HMI device. 
• Then return to "Transfer" mode. 
The changed MP/PROFIBUS DP settings will be overwritten in the following cases: 
• The project is started again. 
• A project is transferred. 
Transfer settings 
A project can only be transferred from the configuration computer to the HMI device when 
at least one of the data channels is enabled on the HMI device.  
If the HMI device is in "Transfer" mode while changes are made to the transfer settings, 
the settings only go into effect after the transfer function is restarted. 

Requirement 

The "S7-Transfer Settings" dialog has been opened with the "S7-Transfer Settings"  
button. 

 
 

① Network selection 
② Button for opening the properties dialog 
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Procedure 
Proceed as follows:  
1. Select a network. 
2. Open the "MPI" or "PROFIBUS" dialog with the "Properties" button: 

 

 
 

① The HMI device is the only master on the bus. 
② Bus address of the HMI device 
③ Time-out 
④ Data transmission rate in total network 
⑤ Highest station address in the network 
⑥ Profile 
⑦ Button for displaying the bus parameters 

3. If more masters are connected to the bus, deactivate the check box "Panel is the only 
master on the bus". 

4. Enter the bus address for the HMI device in the "Address" input field. 
 
  Notice 

The bus address in the "Address" input field must be unique throughout the 
MPI/PROFIBUS DP network. 

 
5. Select the transmission rate in the "Transmission rate" input field. 
6. Select the highest station address on the bus in the "Highest Station Address" or "Highest 

Station" field. 
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7. Select the desired profile from the "Profile" selection field. 
8. The profile information is displayed when you select "Bus Parameters" button in the 

PROFIBUS dialog. The "Profile" dialog is read-only. 
 
  Notice 

The bus parameters must be the same for all stations in the MPI/PROFIBUS DP network.

 
 

9. Close the "Profile" dialog. 
10. Confirm your entries in the "MPI" or "PROFIBUS" dialog. 

The dialog closes. 

Result 
The MPI/PROFIBUS DP settings of the HMI device have been changed.  

6.7.2 Configuring the Data Channel 

Introduction 
If you block all data channels, the HMI device is protected against unintentional overwriting 
of the project data and HMI device image.  

 
 Note 

A project can only be transferred from the configuration computer to the HMI device when at 
least one of the data channels is enabled on the HMI device.  
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Requirement 

The "Transfer Settings" dialog has been opened with the "Transfer Settings"  button.  

 
 

① Group for data channel 1 (Channel 1) 
② Group for data channel 2 (Channel 2) 
③ Button for the "MPI/DP - Transfer Settings" dialog or "Network Configuration" 

 

 
 Note 

"Remote Control" for Channel 1 
Only select the "Remote Control" check box in the "Channel 1" group, if serial transfer is in 
progress. Clear the check box before changing to "Online" mode. 

Procedure 
Proceed as follows:  
1. Activate the required data channel with the respective "Enable Channel" check box in the 

"Channel 1" or "Channel 2" group. 
In the "Channel 1" group, the RS 422/RS 485 port is configured for the serial data 
transfer. 
– Activate the "Enable Channel" check box to enable the data channel. 
– Deactivate the "Enable Channel" check box to lock the data channel. 

2. Enable automatic transfer by activating the respective "Remote Control" check box in the 
"Channel 1" or "Channel 2" group. 

 

 
 Warning 

Unintentional Transfer Mode 
Ensure that the configuration computer does not inadvertently switch the HMI device to 
transfer mode during the open project. This could cause unintentional actions to be 
triggered in the plant. 
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3. Select the required protocol for "Channel 2" in the selection field. 
4. Enter further parameters if required. 

– Applies to "MPI/PROFIBUS DP": 
Select the "Advanced" button if you wish to switch to the "S7-Transfer Settings" dialog. 
You can change the settings for MPI/PROFIBUS DP there. 
Confirm your entries. 
The "S7-Transfer Settings" dialog closes. 

– Applies to "ETHERNET": 
Select the "Advanced" button if you wish to switch to the Network Configuration" 
dialog. You can change the TCP/IP settings there. 
Confirm your entries. 
The "Network Configuration"  dialog closes. 

– Applies to "USB" 
No further settings are required for "USB". 

5. Confirm your entries. 
The "Transfer Settings" dialog closes. 

Result 
The data channel is configured. 

General Information 
 
 Note 

Making Changes in "Transfer" Mode 
If the HMI device is in "Transfer" mode while changes are made to the transfer settings, the 
settings only go into effect after the transfer function is restarted. 
This may occur if the Control Panel is opened to change the transfer properties in an active 
project. 

 
 Notice 

Transfer Mode via Channel 2 
The bus parameters, for example HMI-device address, are read from the project currently 
loaded on the HMI device. 
You can change the settings for the transfer via Channel 2.  
The following steps are required: 
• Close the project. 
• Change the settings on the HMI device. 
• Then return to "Transfer" mode. 
The next time the project is started on the HMI device, the settings will be overwritten by the 
values from the project.  
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See also 
Changing MPI/PROFIBUS DP Settings (Page 6-30) 
Changing the Network Configuration (Page 6-40) 

6.7.3 Enabling PROFINET IO 

PROFINET IO 
If the HMI device is connected to the PLC via PROFINET, function keys or buttons, for 
example, can be configured as PROFINET IO direct keys. If PROFINET IO direct keys are 
used in the project, they must be enabled. 

 
 Note 

If you enable PROFINET IO direct keys, you cannot use the RS 422/RS 485 port for serial 
communication.  
PROFINET IO direct keys and PROFIBUS DP direct keys are mutually exclusive. 

Requirement 

You have opened the "PROFINET" dialog with the "PROFINET"  button. 

 
 

① Check box for enabling or locking the PROFINET IO direct keys 
② Input field for the device name 
③ MAC address of the HMI device 

Procedure 
1. Select the "PROFINET IO enabled" check box to enable PROFINET IO direct keys. 
2. Enter the device name of the HMI. 

 
  Notice 

The device name must match the device name entered in the HW Config of STEP 7. This 
device name is not the device name under Windows CE. 

3. Confirm your entries. 
The dialog closes. 

4. Reboot the HMI after saving the settings. 
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Result 
The PROFINET IO direct keys are enabled.  

See also 
Restarting the HMI Device (Page 6-26) 

6.8 6.8 Configuring Network Operation 

6.8.1 Overview of Network Operation 

Introduction 
Connect the HMI device to the PROFINET network, using the Ethernet port. 
Connection to a network can offer the following advantages: 
• Printing via a network printer 
• Saving, exporting and importing recipe data records to or from a server 
• Setting up of message and data archives 
• Transferring projects 
• Backing up data 
If the HMI device is connected to a PC via a direct connection, you can only use the 
peripheral equipment connected to the PC. 

 
 Notice 

The HMI device can only be used in PROFINET networks. 
The HMI device only has client functionality in the PC network. This means that users can 
access files of a node with TCP/IP server functionality from the HMI device via the network. 
However, it is not possible to access files on the HMI device via the network from a PC. 

 
 Note 

Information on communication using SIMATIC S7 via PROFINET is provided in the "WinCC 
flexible Communication" user manual. 

Addressing 
Within a PROFINET network, computers are usually addressed using network names. These 
network names are translated from a DNS or WINS server to TCP/IP addresses. This is why 
a DNS or WINS server is needed for addressing via device names when the HMI device is in 
a PROFINET network.  
Appropriate servers are usually available in PROFINET networks.  
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 Note 
The use of TCP/IP addresses to address PCs is not supported by the operating system.  

 
Consult your network administrator if you have questions in this regard. 

Printing via a Network Printer 
The HMI device's operating system does not support line by line alarm logging via a network 
printer. All other printer functions, such as printing hardcopies or logs, are possible via the 
network without restriction. 

Preparation 
Before beginning the configuration, request the following network parameters from your 
network administrator.  
• Does the network use DHCP for dynamic assignment of network addresses? 

If not, get a new TCP/IP network address for the HMI device. 
• TCP/IP address of the default gateway 
• Address of the name server in a DNS network 
• Addresses of the name server in a WINS network 

General Procedure for Configuring the Network 
The HMI device must be configured prior to network operation. The configuration is basically 
divided into the following steps:  
Proceed as follows: 
1. Set the computer name of the HMI device. 
2. Configure the network address. 
3. Set the logon information. 
4. Save the settings. 
5. Restart the HMI device once the network is configured. 

If your network address is assigned automatically: 
Before switching the HMI device on, insert the network cable in the corresponding port. A 
unique IP address for the HMI device is assigned during startup.  

See also 
Restarting the HMI Device (Page 6-26) 
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6.8.3 Changing the Network Configuration 

Requirement  

The "Network Configuration" dialog has been opened with the "Network "  button. 

 
 

① Selection for Ethernet card 
② MAC address of the HMI device 
③ Button for the properties dialog 

Procedure 
Proceed as follows: 
1. Select the entry "SMSC100FD1: Onboard LAN Ethernet Driver". 
2. Open the "Onboard LAN Ethernet Driver" dialog with the "Properties" button: 

 
① Address assignment setting 
② Input field for the IP address 
③ Input field for the address of the subnet mask 
④ Input field for the address of the default gateway 
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8. The restore process is resumed. All data stored on the flash file system is restored. After 
successful restore, the following message is displayed: "Restore successfully finished. 
Click "OK" and remove your storage card and reboot your device" 
Remove the memory card. 
Acknowledge this message. 

9. The HMI device reboots. 

Result 
The data from the memory card is now on the HMI device.  

See also 
Using a Memory Card with the HMI device (Page 5-3) 
Displaying Information about the HMI Device  (Page 6-27) 
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Commissioning a Project 7
7.1 7.1 Overview 

Configuration and Process Control Phase 
HMI devices can be used to operate and monitor tasks in process and production 
automation. The plant screens on the HMI devices are used to provide a clearer overview of 
active processes. The HMI device project, which includes the plant screens, is created 
during the configuration phase. 
Once the project is transferred to the HMI device, current processes can be operated and 
monitored in the process control phase. The HMI device is connected to a PLC in the plant 
and exchanges values with this PLC.  

 
Figure 7-1 Configuration and process control phases 

Transferring the Project to the HMI Device 
You can transfer a project to an HMI device as follows: 
• Transfer the project from the configuration computer 
• Restore the project from a PC using ProSave 

In this case, an archived project is transferred from a PC to the HMI device. The 
configuration software need not be installed on this PC. 



Commissioning a Project  
7.2 Operating Modes 

 TP 277, OP 277 (WinCC flexible) 
7-2 Operating Instructions, 09/2007, 6AV6691-1DH01-0AB0 

Commissioning and Recommissioning 
• When the HMI device is commissioned there is no project at first. 

The HMI device is also in this state after the operating system has been updated.  
• When recommissioning, any project already on the HMI device is replaced. 

7.2 7.2 Operating Modes 

Operating Modes 
The HMI device may be in the following operating modes:  
• Offline 
• Online 
• Transfer 
"Offline mode" and "Online mode" can be set on both the configuration computer and the 
HMI device. To set these modes on the HMI device, use a corresponding operator control of 
the project.  

Changing the Operating Mode  
The configuration engineer must have configured an appropriate operator control to allow a 
change of the operating mode on the HMI device during ongoing operation. 
Further information on this may be available in your plant documentation. 

"Offline" Operating Mode 
In this mode, there is no communication between the HMI device and PLC. Although the 
HMI device can be operated, it cannot exchange data with the PLC. 

"Online" Operating Mode 
In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI 
device according to your system configuration. 

"Transfer" Mode 
In this mode, you can transfer a project from the configuration computer to the HMI device or 
backup and restore HMI device data, for example. 
The following options are available for setting "Transfer" mode on the HMI device:  
• When the HMI device starts up 

Start "Transfer" mode manually in the HMI device Loader. 
• During ongoing operation 

Start the "Transfer" mode manually within the project using an operator control. The HMI 
device toggles to "Transfer" mode when automatic mode is set and a transfer is initiated 
on the configuration computer. 
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7.3 7.3 Reusing Existing Projects 
The table below shows how you can reuse existing projects, while observing the screen size: 

 
HMI device in the existing project New HMI device 
TP 270 6" TP 277 6" 
OP 270 6" OP 277 6" 
MP 270 6" Touch TP 277 6" 1) 

 
1) If you have set options on the MP 270 6" Touch, you must use the MP 277 8" Touch as the 

successor.  

The following cases are possible:  
1. An old project in ProTool is available: 

Migrate the project to WinCC flexible and then switch the HMI device.  
2. An old project in WinCC flexible is available: 

Switch the HMI device in WinCC flexible.  
For more information, please see the online help for WinCC flexible or the "WinCC flexible 
Migration" user manual. 

7.4 7.4 Data Transmission Options 

Overview 
The table below shows the options for data transfer between TP 277 or OP 277 and the 
configuration computer. 

 
Type Data channel TP 277 OP 277 

Serial 1) Yes Yes 
MPI/PROFIBUS DP Yes Yes 
USB Yes Yes 

Backup 

Ethernet Yes Yes 
Serial 1) Yes Yes 
MPI/PROFIBUS DP Yes Yes 
USB Yes Yes 

Restore 

Ethernet Yes Yes 
Serial, with bootstrapping 1) Yes Yes 
Serial 1) Yes Yes 
MPI/PROFIBUS DP Yes Yes 
USB Yes  Yes  

Updating the operating system 

Ethernet Yes Yes 
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Type Data channel TP 277 OP 277 
Serial 1) Yes Yes 
MPI/PROFIBUS DP Yes Yes 
USB Yes Yes 

Transferring a project 

Ethernet Yes Yes 
Serial 1) Yes Yes 
MPI/PROFIBUS DP Yes Yes 
USB Yes Yes 

Installing or removing an option 

Ethernet Yes Yes 
Serial 1) Yes Yes 
MPI/PROFIBUS DP Yes Yes 
USB Yes Yes 

Transferring license keys and 
uploading license keys 

Ethernet Yes Yes 

 
1) Applies when PC/PPI cable is used 

7.5 7.5 Transfer 

7.5.1 Overview 

Transfer 
Transfer the executable project from the configuration computer to the HMI device.  
You can start the "Transfer" mode manually or automatically on the HMI device. 
Transferred data is written directly to the internal flash memory on the HMI device. For the 
transfer, you use a data channel which you have to configure before starting a transfer. 

Upload 
You have the option to transfer the compressed project file together with the runtime project 
to the HMI device. If necessary, the compressed project file can be retransferred and edited.  
The HMI device must be equipped with an external memory card to which the compressed 
project file can be saved.  

 
 Notice 

Compressed project file 
WinCC flexible does not check whether the compressed project file stored on the HMI device 
corresponds to the existing runtime project.  
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7.5.2 Starting Manual Transfer 

Introduction 
You can manually switch the HMI device to "Transfer" mode as follows:  
• With a configured operator control during ongoing operation. 
• In the Loader of the HMI device. 

Requirements 
• The project "*.hmi" is opened in WinCC flexible. 
• The HMI device is connected to a configuration computer. 
• The data channel is configured on the HMI device. 
• The HMI device is in "Transfer" mode. 

Procedure 
Proceed as follows: 
1. On the configuration computer, select the "Transfer settings" command in the menu 

"Project > Transfer" in WinCC flexible. 
The "Select devices for transfer" dialog opens.  

2. Select the HMI device in the left area of the dialog. 
3. Select the type of connection between the HMI device and the configuration computer. 

Set the connection parameters. 
4. Set the transfer parameters in the right area of the dialog. 
5. If you wish to transfer the compressed project file together with the runtime project to the 

HMI device: 
Select the "Activate Upload" check box. 

6. Start transfer in WinCC flexible with "Transfer". 
The configuration computer checks the connection to the HMI device. The project is 
transferred to the HMI device. If the connection is not available or is defective, an error 
message is displayed on the configuration computer.  

Result 
When the transfer is completed successfully, the project can be found on the HMI device. 
The transferred project is then started automatically. 

See also 
Operating Modes (Page 7-2) 
Configuring the Data Channel (Page 6-33) 
Data Transmission Options (Page 7-3) 
Overview (Page 7-4) 
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7.5.3 Starting Automatic Transfer 

Introduction 
The HMI device can be automatically switched to "Transfer" mode during runtime as soon as 
transfer is started on the configuration computer connected. 
Automatic transfer is particularly suited for the test phase of a new project since transfer is 
completed without interfering with the HMI device. 
Automatic transfer is available for the following data channels: 
• Serial 
• MPI/PROFIBUS DP 
• USB 
• Ethernet 

 
  Notice 

If the automatic transfer has been activated on the HMI device and a transfer is initiated 
on the configuration computer, the project currently running is automatically stopped. The 
HMI device then automatically switches to "Transfer" mode. 
After the commissioning phase, deactivate the automatic transfer so that the HMI device 
cannot be inadvertently switched to Transfer mode. The transfer mode can trigger 
unintentional actions in the device. 
You can set a password for the Loader of the HMI device to restrict access to the transfer 
settings and thus avoid unauthorized modifications. 

Requirements 
• The project *.hmi is opened in WinCC flexible. 
• The HMI device is connected to a configuration computer. 
• The data channel is configured on the HMI device. 
• The automatic transfer is activated in the data channel for the transfer. 
• The project is started on the HMI device. 
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Procedure 
Proceed as follows: 
1. On the configuration computer, select the "Transfer settings" command in the menu 

"Project > Transfer" in WinCC flexible. 
The "Select devices for transfer" dialog opens.  

2. Select the HMI device in the left area of the dialog. 
3. Select the type of connection between the HMI device and the configuration computer. 

Set the connection parameters. 
4. Set the transfer parameters in the right area of the dialog. 
5. If you wish to transfer the compressed project file together with the runtime project to the 

HMI device: 
Select the "Activate Upload" check box. 

6. Start transfer in WinCC flexible with "Transfer". 
The configuration computer checks the connection to the HMI device. The HMI device 
ends the current project and automatically switches to "Transfer" mode The project is 
transferred to the HMI device. If the connection is not available or is defective, an error 
message is displayed on the configuration computer. 

Result 
When the transfer is completed successfully, the project can be found on the HMI device. 
The transferred project is then started automatically. 

See also 
Data Transmission Options (Page 7-3) 
Configuring the Data Channel (Page 6-33) 
Operating Modes (Page 7-2) 
Overview (Page 7-4) 

7.5.4 Testing a Project 

Introduction 
There are two options to test a project: 
• Test the project on the configuration PC 

You can test a project at a configuration PC, using a simulator. For detailed information, 
refer to the "WinCC flexible" user manual and to the WinCC flexible Online Help. 

• Offline testing of the project on the HMI device 
Offline testing means that communication between the HMI device and PLC is down 
while the test is being carried out. 



Commissioning a Project  
7.5 Transfer 

 TP 277, OP 277 (WinCC flexible) 
7-8 Operating Instructions, 09/2007, 6AV6691-1DH01-0AB0 

• Online testing of the project on the HMI device 
Online testing means that the HMI device and PLC communicate with each other during 
testing. 

Perform the tests, starting with the "Offline test", followed by the "Online test". 
 
 Note 

You should always test the project on the HMI device on which the project will be used. 
 

Check the following: 
1. Check the correct layout of the screens. 
2. Check the screen structure. 
3. Check the input objects. 
4. Enter the tag values. 
The test increases the certainty that the project will run error-free on the HMI device.  

Requirements for Offline Testing 
• The project has been transferred to the HMI device. 
• The HMI device is in "Offline" mode. 

Procedure 
In "Offline" mode, you can test individual project functions on the HMI device without them 
being affected by the PLC. PLC tags, therefore, are not updated.  
Test the operator controls and visualization of the project as far as possible without 
connecting to the PLC.  

Requirements of Online Testing 
• The project has been transferred to the HMI device. 
• The HMI device is in "Online" mode. 

Procedure 
In "Online" mode, you can test individual project functions on the HMI device without them 
being affected by the PLC. PLC tags are updated in this case.  
You have the option to test all communication-dependent functions, e.g. messages, etc. 
Test the operator controls and views of the project.  

See also 
Operating Modes (Page 7-2) 
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7.5.5 Starting Upload 

Requirements 
• No project is open in WinCC flexible. 
• The HMI device is connected to a configuration computer. 
• The data channel is configured on the HMI device. 
• The HMI device is in "Transfer" mode. 
• The memory card containing the compressed project file is inserted into the HMI device. 

Procedure 
Proceed as follows: 
1. On the configuration computer, select the "Communication settings" command in the 

menu "Project > Transfer" in WinCC flexible. 
The "Communication Settings" dialog opens.  

2. Select the type of HMI device. 
3. Select the type of connection between the HMI device and the configuration computer. 

Set the connection parameters. 
4. Close the dialog with "OK". 
5. Select the "Transfer" > "Upload" command in the "Project" menu. 

The "Upload" dialog opens.  
6. Click "OK" to start the upload process. 

The configuration computer checks the connection to the HMI device. The compressed 
project file is uploaded from the HMI device to the configuration PC. If the connection is 
not available or is defective, an error message is displayed on the configuration 
computer.  

Result 
After successful upload, the project is opened on the configuration PC in WinCC flexible.  

See also 
Overview (Page 7-4) 
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7.6 7.6 Backup and Restore 

7.6.1 Overview 

Backup and Restore 
 
 Notice 

License Keys 
License keys are not taken into account for backups and restores. License keys are saved in 
the working memory of the HMI device and cannot be deleted.  

 
You can back up and restore the following data found in the internal flash memory of the HMI 
device with a PC: 
• Project and HMI device image 
• Password list 
• Recipe data 
Use one of the following tools for backup and restore: 
• WinCC flexible 
• ProSave 

General Information 
 
 Notice 

Power failure 
If a complete restore operation is interrupted due to power failure on the HMI device, the 
operating system of the HMI device may be deleted! The operating system then has to be 
updated. 
Compatibility conflict 
If a message is output on the HMI device warning of a compatibility conflict during the 
restore operation, the operating system must be updated. 

7.6.2 Backup and Restore Operations with WinCC flexible 

Requirements 
• The HMI device is connected to a configuration computer. 
• No project is open in WinCC flexible. 
• The data channel is configured on the HMI device. 
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Procedure – Backup 
Proceed as follows: 
1. On the configuration computer, select the "Communication settings" command in the 

menu "Project > Transfer" in WinCC flexible. 
The "Communication Settings" dialog opens. 

2. Select the type of HMI device. 
3. Select the type of connection between the HMI device and the configuration computer. 

Set the connection parameters. 
4. Close the dialog with "OK". 
5. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible. 

The "Backup Settings" dialog opens. 
6. Select the data to be backed up. 
7. Select a destination folder and a file name for the "*.psb" backup file. 
8. Set "Transfer" mode on the HMI device. 

If automatic transfer mode is enabled on the HMI device, the HMI device automatically 
sets "Transfer" mode when a backup is initiated. 

9. Start the backup operation in WinCC flexible with "OK" on the configuration computer. 
Follow the instructions in WinCC flexible.  
A status view opens to indicate the progress of the operation.  

Result 
The system outputs a message when the backup is completed.  
The relevant data is now backed up on the configuration computer. 

Procedure – Restore 
Proceed as follows: 
1. On the configuration computer, select the "Communication settings" command in the 

menu "Project > Transfer" in WinCC flexible. 
The "Communication Settings" dialog opens. 

2. Select the type of HMI device. 
3. Select the type of connection between the HMI device and the configuration computer. 

Set the connection parameters. 
4. Close the dialog with "OK". 
5. Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible. 

The "Restore Settings" dialog opens.  
6. Select the "*.psb" backup file to be restored from the "Open" dialog. 

You can see the HMI device for which the backup file was created and the type of backup 
data the file contains. 
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7. Set "Transfer" mode on the HMI device. 
If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when a restore operation is initiated. 

8. Start the restore operation in WinCC flexible with "OK" on the configuration computer. 
Follow the instructions in WinCC flexible.  
A status view opens to indicate the progress of the operation.  

Result 
When the restore is successfully completed, the data backed up on the configuration 
computer is now on the HMI device. 

See also 
Overview (Page 7-10) 
Operating Modes (Page 7-2) 
Data Transmission Options (Page 7-3) 
Configuring the Data Channel (Page 6-33) 

7.6.3 Backup and Restore with the ProSave 

Requirements 
• The HMI device is connected to a PC on which ProSave is installed. 
• The data channel is configured on the HMI device. 

Procedure – Backup 
Proceed as follows: 
1. From the Windows Start menu, start ProSave on the PC. 
2. Select the HMI device type in the "General" tab. 
3. Select the type of connection between the HMI device and the PC. 

Set the connection parameters.  
4. Select the data to be backed up in the "Backup" tab. 
5. Select a destination folder and a file name for the "*.psb" backup file. 
6. Set "Transfer" mode on the HMI device. 

If automatic transfer mode is enabled on the HMI device, the HMI device automatically 
sets "Transfer" mode when a backup is initiated. 

7. Start the backup operation in ProSave with "Start Backup". 
Follow the instructions in ProSave.  
A status view opens to indicate the progress of the operation.  
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Result 
The system outputs a message when the backup is completed.  
The relevant data is now backed up on the PC. 

Procedure – Restore 
Proceed as follows: 
1. From the Windows Start menu, start ProSave on the PC. 
2. Select the HMI device type in the "General" tab. 
3. Select the type of connection between the HMI device and the PC. 

Set the connection parameters.  
4. Select the "*.psb" backup file to be restored from the "Restore" tab. 

You can see the HMI device for which the backup file was created and the type of backup 
data the file contains. 

5. Set "Transfer" mode on the HMI device. 
If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when a restore operation is initiated. 

6. Start the restore operation in ProSave on the PC with "Start Restore". 
Follow the instructions in ProSave.  
A status view opens to indicate the progress of the operation.  

Result 
When the restore is successfully completed, the data backed up on the PC is now on the 
HMI device. 

See also 
Overview (Page 7-10) 
Operating Modes (Page 7-2) 
Data Transmission Options (Page 7-3) 
Configuring the Data Channel (Page 6-33) 
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7.7 7.7 Updating the Operating System 

7.7.1 Overview 

Updating the Operating System 
A compatibility conflict may occur when transferring a project to the HMI device. This is 
caused by different versions of the configuration software used and the HMI device image 
available on the HMI device. If there are different versions, the transfer is aborted. A 
message indicating a compatibility conflict is displayed on the configuration computer. 
There are two ways to match the versions: 
• Update the HMI device image if the project was created with the most recent version of 

the configuration software. 
• Transfer a matching older version of the HMI device image if you do not want to adapt the 

project to the most recent version of the configuration software for the project. 
 
  Notice 

Data Loss 
All data on the HMI device, such as the project, passwords and licenses, will be deleted 
when you update the operating system. 
Data channels 
An operating system update resets all parameters for the data channels. The transfer can 
only be started in the Loader following reconfiguration of the data channels. 

7.7.2 Bootstrapping 

Bootstrapping 
In ProSave or WinCC flexible, you can update the operating system with or without 
bootstrapping.  
• Updating the operating system without bootstrapping 

First, set "Transfer" mode on the HMI device or use the automatic transfer function if the 
project is active. Then start the operating system update in ProSave or WinCC flexible.  

• Updating the operating system with bootstrapping 
First, start the operating system update in ProSave or WinCC flexible and switch the 
power on the HMI device off and on again when prompted. 
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  Note 
You have to perform an operating system update with bootstrapping if the HMI device 
does not yet have an operating system or if the operating system of the HMI device is 
corrupt. 
Point-to-point coupling with a PC/PPI cable is necessary in order to update the operating 
system with bootstrapping. 

7.7.3 Updating the Operating System Using WinCC flexible 

Requirement 
• The HMI device is connected to a configuration computer. 
• No project is open in WinCC flexible. 
• Relevant only to operating system update without bootstrapping: 

The data channel is configured on the HMI device.  

Procedure 
Proceed as follows:  
1. Relevant to operating system update with bootstrapping: 

Switch off power to the HMI device.  
2. On the configuration computer, select the "Communication settings" command in the 

menu "Project > Transfer" in WinCC flexible. 
The "Communication Settings" dialog opens. 

3. Select the type of HMI device. 
4. Select the type of connection between the HMI device and the configuration computer, 

then set the connection parameters. 
5. Close the dialog with "OK". 
6. In WinCC flexible, select the command "Update operating system" in the "Project > 

Transfer" . 
7. Select whether to update the operating system with or without bootstrapping by setting 

the "Bootstrap" check box accordingly. 
8. In "Image path," select the HMI device image file, "*.img". 

The HMI device image files are available under "WinCC flexible Images" in the 
WinCC flexible installation folder or on the WinCC flexible installation CD.  
In the output area, you are provided information on the version of the HMI device image 
file after it is opened. 
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9.  Applies only when updating without bootstrapping: 
 Set "Transfer" mode on the HMI device.  
 If automatic transfer mode is enabled on the HMI device, the device automatically sets 
 "Transfer" mode when an update is initiated.  

10.  In WinCC flexible, select "Update OS" on the configuration PC to run the operating 
 system update. 

11.  Applies only when updating with bootstrapping: 
 Switch on the power supply to the HMI device.  

12.  Follow the instructions in WinCC flexible. 
 During the operating system update a status view opens to indicate progress.  

Result 
A message is displayed when the operating system update is successfully completed.  
This operation has deleted the project data from the HMI device.  

See also 
Overview (Page 7-10) 
Operating Modes (Page 7-2) 
Data Transmission Options (Page 7-3) 
Configuring the Data Channel (Page 6-33) 

7.7.4 Updating the Operating System Using ProSave 

Requirement 
• The HMI device is connected to a PC on which ProSave is installed. 
• When updating the operating system without bootstrapping: 

The data channel is configured on the HMI device.  

Procedure 
Proceed as follows:  
1.  When updating the operating system with bootstrapping: 

 Switch off power to the HMI device.  
2.  From the Windows Start menu, start ProSave on the PC. 
3.  Select the HMI device type in the "General" tab. 
4.  Select the type of connection between the HMI device and the PC, then set the 

 connection parameters. 
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5.  Select the "OS Update" tab. 
6.  Select whether to update the operating system with or without bootstrapping by setting 

 the "Bootstrap" check box accordingly. 
7.  In "Image path," select the HMI device image file, "*.img". 

 The HMI device image files are available under "WinCC flexible Images" in the 
 WinCC flexible installation folder or on the WinCC flexible installation CD.  
 In the output area, you are provided information on the version of the HMI device image 
 file after it is opened. 

8.  Applies only when updating without bootstrapping: 
 Set "Transfer" mode on the HMI device.  
 If automatic transfer mode is enabled on the HMI device, the device automatically sets 
 "Transfer" mode when an update is initiated.  

9.  Select "Update OS" on the PC to run the operating system update. 
10.  Applies only when updating with bootstrapping: 

 Switch on the power supply to the HMI device.  
11.  Follow the instructions in ProSave. 

 During the operating system update a status view opens to indicate progress.  

Result 
A message is displayed when the operating system update is successfully completed.  
This operation has deleted the project data from the HMI device. 

7.8 7.8 Installing and Removing Options 

7.8.1 Overview 

Installing and Removing Options 
You can install options on the HMI device, for example, additional programs developed 
especially for the HMI device.  
You can also remove the option from the HMI device again.  

 
 Note 

License key 
A license key may be needed to run an option. The license key unlocks the option for use.  
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7.8.2 Installing and Removing Options Using WinCC flexible 

Requirements 
• The HMI device is connected to a configuration computer. 
• No project is open in WinCC flexible. 
• The data channel is configured on the HMI device. 

Procedure – Installing an Option 
Proceed as follows: 
1. On the configuration computer, select the "Communication settings" command in the 

menu "Project > Transfer" in WinCC flexible. 
The "Communication Settings" dialog opens. 

2. Select the type of HMI device. 
3. Select the type of connection between the HMI device and the configuration computer, 

then set the connection parameters. 
4. Close the dialog with "OK". 
5. Select the "Options" command in the menu "Project > Transfer" in WinCC flexible. 
6. Select the desired option under "Available options." 
7. Set "Transfer" mode on the HMI device. 

If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when the installation of an option is initiated. 

8. Start the installation of the option in WinCC flexible on the configuration computer with 
the ">>" button. 
Follow the instructions in WinCC flexible.  
A status display appears indicating the progress of the installation.  

Result 
The option has now been installed on the HMI device.  

Procedure – Removing an Option 
Proceed as follows: 
1. On the configuration computer, select the "Communication settings" command in the 

menu "Project > Transfer" in WinCC flexible. 
The "Communication Settings" dialog opens. 

2. Select the type of HMI device. 
3. Select the type of connection between the HMI device and the configuration computer, 

then set the connection parameters. 
4. Close the dialog with "OK". 
5. Select the "Options" command in the menu "Project > Transfer" in WinCC flexible. 
6. Select the desired option under "Installed options." 
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7. Set "Transfer" mode on the HMI device. 
If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when the removal of an option is initiated. 

8. Start the removal of the option in WinCC flexible on the configuration computer with the 
"<<" button. 
Follow the instructions in WinCC flexible.  
A status display appears indicating the progress of the removal.  

Result 
The option has now been removed on the HMI device.  

See also 
Overview (Page 7-10) 
Operating Modes (Page 7-2) 
Data Transmission Options (Page 7-3) 
Configuring the Data Channel (Page 6-33) 

7.8.3 Installing and Removing Options Using ProSave 

Requirements 
• The HMI device is connected to a PC on which ProSave is installed. 
• The data channel is configured on the HMI device. 

Procedure – Installing an Option 
Proceed as follows: 
1. From the Windows Start menu, start ProSave on the PC. 
2. Select the HMI device type in the "General" tab. 
3. Select the type of connection between the HMI device and the PC, then set the 

connection parameters. 
4. Select the "Options" tab. 
5. Select the desired option under "Available options." 
6. Set "Transfer" mode on the HMI device. 

If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when the installation of an option is initiated. 

7. Start the installation of the option in ProSave with the ">>" button. 
Follow the instructions in ProSave.  
A status display appears indicating the progress of the installation.  
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Result 
The option has now been installed on the HMI device.  

Procedure – Removing an Option 
Proceed as follows: 
1. From the Windows Start menu, start ProSave on the PC. 
2. Select the HMI device type in the "General" tab. 
3. Select the type of connection between the HMI device and the PC, then set the 

connection parameters. 
4. Select the "Options" tab. 
5. Select the desired option under "Installed options." 
6. Set "Transfer" mode on the HMI device. 

If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when the removal of an option is initiated. 

7. Start the removal of the option in ProSave with the "<<" button. 
Follow the instructions in ProSave.  
A status display appears indicating the progress of the removal.  

Result 
The option has now been removed on the HMI device.  

See also 
Overview (Page 7-10) 
Operating Modes (Page 7-2) 
Data Transmission Options (Page 7-3) 
Configuring the Data Channel (Page 6-33) 

7.9 7.9 Transferring and Uploading License Keys 

7.9.1 Overview 

Transferring and Uploading License Keys 
With the purchase of an optional package, you obtain a specific user license with an 
associated license key. Once you have installed an option, transfer a license key to the HMI 
device. The license key unlocks an option for use.  
You can also upload the license key from the HMI device to a license diskette.  
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11.4 11.4 Spare Parts and Repairs 

Repairs 
In case of repair, the HMI device must be shipped to the Return Center in Fürth. Repairs 
may only be carried out at the Return Center in Fürth. 
Depending on the work necessary to repair the device, the Center might decide to give you a 
credit not. In this case, it is your responsibility to order a new device. 
The address is: 
A&D Return Center 
Siemensstr. 2 
90766 Fürth, Germany 

Service Pack 
A service pack for maintenance is available with order number 6AV6671-3XA01-0AX0.  
The service pack includes: 
• Mounting seal 
• Mounting clamps 
• Labeling strips 
• Terminal block, 2-pin 
The service pack can be ordered from your Siemens representative.  

Service & Support on the Internet 
Service & Support provides additional comprehensive information on SIMATIC products 
through online services at "http://www.siemens.com/automation/support": 
Information about on-site services, repairs, spare parts, and much more is available on our 
"Services" pages. 

 

http://www.siemens.com/automation/support
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12.4 12.4 Description of the Ports 

12.4.1 Power Supply 
Plug connector, 2-pin 

 
Figure 12-1 Power supply pin assignment 

 
Pin Assignment 
1 +24 VDC 
2 GND 24 V 

12.4.2 RS 422/RS 485 (IF 1B) 
Sub-d socket, 9-pin, with screw lock 

 
Figure 12-2 Pin assignment of the RS 422/RS 485 interface 

 
Pin Assignment for the RS 422 Assignment for the RS 485 
1 n. c. n. c. 
2 GND 24 V GND 24 V 
3 TxD+ Data channel B (+) 
4 RD+ RTS 1) 
5 GND 5 V, floating GND 5 V, floating 
6 +5 VDC, floating +5 VDC, floating 
7 +24 VDC, out (max. 100 mA) +24 VDC, out (max. 100 mA) 
8 TxD– Data channel A (–) 
9 RxD– RTS 1) 

 
1) On pin 4 or pin 9, can be set with DIP switch on the rear of the device 
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12.4.3 USB 
USB standard connector 

 
Figure 12-3 Pin assignment of the USB port 

 
Pin Assignment 
1 +5 VDC, out (max. 100 mA) 
2 USB-DN 
3 USB-DP 
4 GND 

12.4.4 Ethernet 
RJ45 plug connector 

 
Figure 12-4 Pin assignment of the RJ45 connector 

 
Pin Assignment 
1 TX+ 
2 TX- 
3 RX+ 
4 n.c. 
5 n.c. 
6 RX- 
7 n.c. 
8 n.c. 
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Alarm event, 9-1 
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Alarm log, 9-2 
Alarm report, 9-2 
Alarm view 
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Simple, 9-4 

Alarm View, 9-3 
Alarm window, 9-5 
ALARM_S, 1-6 
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changing, 8-9 
Changing, 8-17 
Entering, 8-9, 8-17 

ALT key, 6-11, 8-13 
Ambient conditions 

Climatic, 3-2 
Mechanical, 3-1 
Test, 3-2 

Ambient temperature, 3-3 
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Applications 

OP 277, 1-1 
TP 277, 1-1 

Authorization, 8-34 
Automatic 

Transfer, 7-6 
Automation License Manager, 7-20 
A-Z key, 6-11, 8-13 

B 
Backing up, 7-3, 7-10, 7-11, 7-12, 8-35 

Registry information, 6-5, 6-22 
Temporary files, 6-22 
To memory card, 6-5, 6-45 
With ProSave, 7-12 
With WinCC flexible, 7-11 

BACKSPACE key, 6-11, 8-13 
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Bar, 8-20 
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Required, i 
Booting, 6-5, 6-26 
Bootstrapping, 7-3, 7-14 
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Bus parameters 

Profile, 6-33 

C 
cabinet 

Working on, 2-1 
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TP 270 
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TP 277 
Applications, 1-1 
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Mounting, 4-1 
Operator control element, 5-1 
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Training Center, iv 
Transfer, 7-1, 7-2, 7-4 

Automatic, 7-6 
Cancel, 4-16 
Manual, 7-5 

Transfer mode 
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Via MPI, 6-31 
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Transfer settings, 6-6, 6-33 
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Directories, 6-29 
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License key, 7-4, 7-21 
Project, 7-1, 7-4 
Recipe data record, 10-15, 10-22 

Transport damage, 4-1 
Trend view, 8-24 
Trends 

Functional scope, 1-8 
Limit violation, 8-24 

U 
UL approval, 2-2 
Unintentional action, 5-2, 8-2 
Unintentional transfer mode, 6-34 
Updating 

About ProSave, 7-16 
Operating system, 7-14 
Via WinCC flexible, 7-15 

Upload, 7-4, 7-9 
Uploading 

License key, 7-4, 7-22 
USB device 

Connecting, 4-14 
USB port 

External device, 4-5 
Pin assignment, 12-7 

Use 

Conditions, 3-1 
In industry, 2-4 
In residential areas, 2-4 
With additional measures, 3-1 

User, 8-34 
Admin, 8-42, 8-43, 8-44 
creating, touch operation, 8-38, 8-40 
Delete, 8-44 
Logoff, 8-38 
Logon, 8-36 
PLC_User, 8-42, 8-43, 8-44 

User data 
Backing up, 8-35 
Changing, 8-42, 8-43 
Restoring, 8-35 

User group, 8-34 
User Interface 

Operating, 6-3 
User manual, i 
User view, 8-35 

Expanded, 8-36 
Simple, 8-36 

Using the RS 485/RS 232 port, 4-12 

V 
Value table 

Trend view, 8-24 
VBScript 

Functional scope, 1-8 

W 
WinCC flexible internet settings 

E-mail, 6-44 
WinCC Internet settings, 6-6 
Windows CE taskbar, 6-2 

Password protection, 6-2 
WINS, 6-41 
WINS server, 6-37 
Wiring diagram 

Configuration PC, 4-12 
Connecting the PLC, 4-10 
Equipotential bonding, 4-7 
Power supply, 4-8 
Printer, 4-15 

Working on the cabinet, 2-1 

 




